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The most important diseases of the faba bean include Ascochyta blight caused by the fungus Ascochyta fabae and choc-
olate spot caused by the fungus Botrytis fabae. The pathogenicity of isolates of A. fabae and B. fabae was investigated 
against six cultivars of faba bean. The technique of detached leaves was used. The leaves were inoculated with pycnidi-
al and conidial spores of the pathogens tested. After incubation, the sizes of the necrotic spots produced by the patho-
gens were determined. Significant variation in the pathogenicity of isolates of both fungi was found. The varieties 
showed differential resistance to Ascochyta blight and chocolate spot. The variation in resistance of cultivars to choco-
late spot was lower than resistance to Ascochyta blight. The possibility of using the ImageJ image analysis software to 
measure the surface of necrotic lesions was described.    
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Do najważniejszych chorób bobiku należą askochytoza powodowana przez grzyb Ascochyta fabae oraz czekoladowa 
plamistość powodowana przez grzyb Botrytis fabae. Przebadano patogeniczność izolatów A. fabae i B. fabae wobec 
sześciu odmian bobiku. Zastosowano technikę odciętych liści. Liście inokulowano zarodnikami piknidialnymi i koni-
dialnymi badanych patogenów. Po inkubacji określano rozmiary plam nekrotycznych wytwarzanych przez patogeny. 
Stwierdzono istotne zróżnicowanie patogeniczności izolatów obu grzybów. Odmiany wykazały zróżnicowaną odpor-
ność na askochytozę i czekoladową plamistość. Zróżnicowanie odporności odmian na czekoladową plamistość było 
mniejsze niż odporności na askochytozę. Opisano możliwość wykorzystania programu do analizy obrazu ImageJ do 
pomiaru powierzchni plam nekrotycznych. 

Słowa kluczowe: analiza obrazu, askochytoza, czekoladowa plamistość, odporność, Vicia faba 

Introduction 

Faba (field, horse) bean (Vicia faba L. ssp. 
minor) is a grain legume crop (Fouad et al., 2013). 
It is cultivated for seeds with a high protein con-
tent (25-30%) and can be a raw material for pro-
ducing protein animal feed (Grela and Czech, 
2019). An additional advantage of faba bean culti-
vation is improving the soil structure by loosening 
it and enriching it with organic matter. Thanks to 
faba bean cultivation, the soil is enriched with ni-
trogen assimilated by rhizobia bacteria. This is 
particularly important in organic farming, where 
artificial nitrogen fertilizers are not used. 

The area of faba bean cultivation in Poland 
was approximately 35,000 hectares in 2022 
(Panek 2022). In the last ten years, it has increased 
almost four times. This area is lower than that of 
lupins, field peas, and soybeans. This is mainly 
due to the high soil requirements of faba bean and 
the high water needs during the period from the 
formation of buds to the formation of pods. Faba 
bean is also strongly affected by pests (aphids, pea 

leaf weevil, broadbean weevil) and pathogens 
causing fungal diseases. Two fungal diseases, As-
cochyta blight, and chocolate spot, pose a signifi-
cant threat to the growth of faba bean crops. Asco-
chyta blight is caused by the fungus Ascochyta 
fabae Speg (teleomorph Didymella fabae Jellis & 
Punith), while chocolate spot is caused by the fun-
gus Botrytis fabae Sard. (Díaz-Ruiz et al., 2009; 
Kaur et al., 2014; Zakrzewska, 2004, 1988). Asco-
chyta blight is a common disease in faba bean 
crops, causing yield losses of up to 90% in suscep-
tible cultivars when environmental conditions fa-
vor disease development (Hanounik and Robert-
son, 1989). The fungus infects all above-ground 
parts of plants, including seeds (Sillero et al., 
2010).  

The resistance of faba bean to Ascochyta 
blight (A. fabae) is a complex trait. It is controlled 
by single main genes and polygenically (Avila et 
al., 2004; Kohpina et al., 2000a; Ondřej and 
Huňady, 2007; Román et al., 2003; Sillero et al., 
2010). Genes associated with resistance of both 
leaves and stems have also been identified, as well 
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as groups of genes that determine resistance of 
leaves or stems only (Kharrat et al., 2006). Fur-
thermore, the presence of resistance QTL effective 
against various isolates of A. fabae was found, but 
also QTL effective only against single isolates 
(Avila et al., 2004). This indicates the need for a 
broad spectrum of A. fabae isolates to test the re-
sistance of the faba bean. Therefore, some re-
searchers have suggested the existence of races of 
the pathogen, but this is not fully documented 
(Díaz-Ruiz et al., 2009; Tivoli et al., 2006). Ra-
ther, in the A. fabae population, pathogenicity 
groups are identified according to the severity of 
disease symptoms caused by isolates on a set of 
cultivars with different resistance (Blake et al., 
2022). Sexual reproduction allows the emergence 
of new combinations of virulence, which is associ-
ated with the possibility that the pathogen re-
sponds to the selection exerted by the introduction 
of host resistance genes (Ozkilinc et al., 2015; Ru-
biales and Trapero-Casas, 2002).  

This level of specialization is not observed in 
B. fabae causing chocolate spot. The degree of 
resistance of faba bean to this disease is low and 
only a few sources of resistance have been identi-
fied (Gela et al., 2022; Sillero et al., 2010).  

Testing the resistance of faba bean to Asco-
chyta blight and chocolate spot is laborious and 
requires the creation of appropriate provocative 
conditions for the development of these diseases 
(Zakrzewska, 2004, 1988). Acceleration of the 
selection process of resistant genotypes can be 
achieved using the technique of detached leaves 
(Herath et al., 2001; Kohpina et al., 2000b; Tivoli 
et al., 2006). In the case of Ascochyta blight, it 
should be considered that the reaction of leaves 
and stems to infection with A. fabae can vary 
(Avila et al., 2004). Therefore, Kohpina et al. 
(2000b) also propose using stem fragments to ob-
tain more reliable results showing the resistance of 
faba bean genotypes to Ascochyta blight. The 
complexity of faba bean reaction to Ascochyta 
blight shows that the correlation between laborato-
ry and field results is not always high. This is due 
to the above-mentioned different resistance of 
leaves and stems to A. fabae infection and the fact 
that the fungus also infects pods (Zakrzewska, 
2004). The development of the disease under field 
conditions is also influenced by the length of the 
stem and the type of inflorescence (Jellis et al., 
1985; Pritchard et al., 1989; Zakrzewska, 2004). 
In the case of the chocolate spot, there was satis-
factory concordance between detached leaf tests 
and field tests (Zaki, 2010). This concordance was 
lowest for genotypes with moderate resistance to 
the disease (Bouhassan et al., 2004; Tivoli et al., 
2006; Villegas-Fernández et al., 2011).  

The research aimed to study the pathogenicity 
of A. fabae and B. fabae isolates and the resistance 
of faba bean cultivars to diseases caused by these 

pathogens using the detached-leaf technique. The 
possibility of using image analysis software for a 
precise and automated assessment of the severity 
of the above diseases on detached faba bean leaves 
was also tested. 

Material and methods 

The pathogenicity of Ascochyta fabae and Bo-
trytis fabae isolates to faba bean cultivars was 
evaluated. Six cultivars of faba bean were used in 
the research: Bobas – traditional cultivar, high in 
tannin; Albus, Amulet, Kasztelan – traditional, low
-tannin cultivars; Granit, Optimal – determinate 
(SK), high tannin cultivars. Faba bean seeds were 
obtained from breeding companies (Albus, Amu-
let, Granit, Kasztelan – Hodowla Roślin Strzelce; 
Bobas, Optimal – DANKO Hodowla Roślin). 

The isolates of A. fabae and B. fabae were 
obtained from leaves showing symptoms of Asco-
chyta blight and chocolate spot and from seeds 
with disease symptoms (Table 1). Isolates are 
stored in the collection of the IHAR-PIB Depart-
ment of Applied Biology. 

To obtain spores, A. fabae, and B. fabae were 
cultured in a medium of PDA (potato glucose 
agar) (Carl Roth GmbH, Karlsruhe, Germany) 
with the addition of faba bean meal (Zakrzewska, 
2004). The dishes were irradiated with UV light 
(black light, 360 nm) in a 12/12h cycle to stimu-
late sporulation (Fig. 1). The surface of the dishes 
on which the sporulation of fungi was observed 
was washed with distilled water. The resulting 
suspension was filtered through gauze to remove 
mycelium fragments. The suspension concentra-
tion of pycnidiospores of A. fabae was established 
at 100,000 spores per milliliter and the conidio-
spores of B. fabae at 500,000 spores per milliliter. 
Measurements of spore concentration were made 
using a Thoma hematology chamber. The same 
concentrations of spores were adjusted for all iso-
lates tested from both species. 

The detached leaf assay was used to assess the 
pathogenicity of isolates and resistance of culti-
vars (Walentyn-Góral and Góral, 2011; Góral and 
Walentyn-Góral, 2012). Sterilized faba bean 
leaves were placed in 12.5 × 12.5 cm square Petri 
dishes (Bionovo, Legnica, Poland). The medium 
was water agar (Carl Roth GmbH, Karlsruhe, Ger-
many) supplemented with 100 mg of benzimidaz-
ole (Merck Life Science Sp. z oo, Poznań, Poland) 
per liter. Each leaflet was inoculated with a drop 

(50 l ) of either A. fabae or B. fabae spore sus-
pension. The drop was placed in the middle of the 
leaflet in a place punctured with a needle. Four to 
five leaflets were inoculated on each leaf. Plates 
with leaves were incubated in a culture chamber 
(Sanyo Electric, Moriguchi, Japan) at 20°C. The 
duration of the day was 12 h. After the symptoms 
appeared, necrotic lesions’ size was measured five 
times (7, 10, 14, 16, and 21 days post-inoculation). 
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Table 1  
Tabela 1  

List of isolates of Ascochyta fabae and Botrytis fabae 
Lista izolatów Ascochyta fabae i Botrytis fabae  

Species 
Gatunek 

Isolate 
Izolat 

Source 
Żródło 

Cultivar 
Odmiana 

Isolation year 
Rok izolacji 

A. fabae AF 5-1 seeds / nasiona  Titus * 

A. fabae AF 5-2 seeds / nasiona  Titus * 

A. fabae AF 6-1 seeds / nasiona  Amulet 2009 

A. fabae AF 6-2 seeds / nasiona  Amulet 2009 

A. fabae AF 7-1 leaves / liście  Kasztelan 2012 

A. fabae AF 7-3 leaves / liście  Granit 2012 

A. fabae AF 8-1 leaves / liście  Bobas 2013 

A. fabae AF 8-2 leaves / liście  Amulet 2013 

A. fabae AF 15-1 seeds / nasiona  Albus 2017 

A. fabae AF 15-4 seeds / nasiona  Granit 2017 

B. fabae BF 1 leaves / liście  Optimal 2017 

B. fabae BF 2 leaves / liście  Optimal 2017 

B. fabae BF 3 leaves / liście  Granit 2017 

B. fabae BF 4 leaves / liście  Granit 2017 

* – seed stored in refrigerator, collected in 2004 
* – nasiona przechowywane w zamrażarce, zebrane w roku 2004 

Fig. 1. Isolate of Ascochyta fabae growing on a PDA medium with faba bean seed meal (left); pycnidispores of A. fabae 
(right) 

Rys. 1. Izolat Ascochyta fabae rosnący na pożywce PDA z mączką z nasion bobiku (z lewej); piknidiospory A. fabae 
(z prawej) 

The average area of the lesion was calculated for 
each leaf. Photographs of the infected leaves were 
taken at 21 dpi. For each pathogen, two infection 
experiments were performed in two replications. 

Statistical analysis was performed using the 
XLSTAT Life Science package (Version 
2021.3.1.1177, Lumivero, Denver, CO, USA). An 
analysis of variance was performed on the mean 
area of necrotic lesions produced by A. fabae and 
B. fabae (XLSTAT: ANOVA procedure). The fac-
tors were: isolate, cultivar, and date of measure-
ment. Fisher's NIR multiple comparison test was 
used to compare the means for cultivars and iso-
lates. 

In selected images, the area of the lesions was 
measured using ImageJ (https://imagej.net) 

(National Institutes of Health, Bethesda, MD, 
United States and the Laboratory for Optical and 
Computational Instrumentation, University of 
Wisconsin, Madison, WI, USA) (Scheider et al., 
2012). This work aimed to verify the possibility of 
using image analysis to assess the size of necrotic 
lesions on faba bean leaves. 

After opening the leaf image (TIFF, GIF, 
JPEG, BMP, and others), initial image adjustments 
were made (e.g. Image > Adjust > Brightness/
Contrast, Image > Adjust > Color balance ). The 
measurement scale of the image was then deter-
mined to obtain the actual area of the measured 
necrotic lesion (Analyze > Set Scale). A necrotic 
lesion was marked and its area was measured us-
ing the Image > Adjust > Color Threshold com-

https://imagej.net
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mand. The highlighted area was outlined using the 
Wand Tool command (icon in the ImageJ icon 
bar). Options of Wand Tool can be modified using 
the command Edit > Options > Wand Tool. The 
area of the selected area was calculated using the 
Analyze > Analyze Particles command. The pro-
cess can be automated by recording a macro in-
cluding the above commands (Plugins > Macros 
> Record). 

Results and Discussion 

All tested isolates of A. fabae and B. fabae 
showed pathogenicity towards the faba bean culti-
vars. Symptoms in the form of necroses appeared 
about seven days after inoculation. Then necroses 
increased, in some cases covering the entire sur-
face of a single leaflet (Fig. 2). The area of necro-
sis produced by B. fabae was on average three 

Fig. 2. A. Necrotic lesions on faba bean leaves (cultivar Kasztelan) caused by A. fabae isolate AF15-5 after point inocula-
tion with pycnidiospores; B. Necrotic lesion on faba bean cultivar Kasztelan with formatting pycnidia of A. fabae, isolate 
AF5-2; C. Necrotic lesion on faba bean leaves (cultivar Amulet) caused by B. fabae after point inoculation with conidio-

spores; D. Pycnidia of A. fabae on a faba bean leaves releasing pycnidiospores.  
Rys. 2. A. Plamy nekrotyczne na liściu bobiku (odmiana Kasztelan) powstałe na skutek inokulacji punktowej zarodnika-
mi grzyba A. fabae, izolat AF 15-5; B. Plama nekrotyczna na liściu bobiku odmiany Kasztelan z tworzącymi się piknidia-
mi grzyba A. fabae, izolat AF 5-2; C. Plama nekrotyczna na liściu bobiku (odmiana Amulet) powstała na skutek inokula-
cji punktowej zarodnikami grzyba B. fabae, izolat BF-1; D. Piknidia grzyba A. fabae na liściu bobiku uwalniające pikni-

diospory.  

times larger than that caused by A. fabae. In ne-
crotic lesions produced on leaves inoculated with 
A. fabae, pycnidia, releasing pycnidiospores were 
formed (Fig. 2D). 

The pathogenicity of A. fabae isolates varied 
(Table 2, Fig. 3). Two groups of isolates were dis-
tinguished according to the size of the necrotic 
lesions. The first included four highly pathogenic 
isolates: 15-4, 15-1, 7-3, and 8-2. The highest 
pathogenicity was shown by isolates 15-4 and 15-
1 obtained in 2015 from infected faba bean seeds 
from a field experiment in Radzików, Central Po-
land. Isolates 7-3 and 8-2 were obtained from in-
fected leaves collected in 2012 and 2013. The sec-
ond group included six isolates with significantly 
lower pathogenicity. The differences between 
them were not statistically significant. A. fabae 

isolates show a wide variation in aggressiveness 
toward field beans (Blake et al., 2022). This is 
because A. fabae is a heterothallic species and the 
presence of two mating types MAT-1 and MAT-2 
is required for the formation of pseudothecia and 
ascospores (Kaiser et al., 2007).  

Faba bean cultivars used for the investigation 
differed statistically significantly in terms of re-
sistance to Ascochyta blight caused by four iso-
lates with the highest pathogenicity (Tab. 3, 
Fig. 4). The Bobas cultivar showed the highest 
resistance. However, it did not differ significantly 
from the Optimal (SK) cultivar. 

Albus was the most susceptible cultivar. 
Kasztelan, Granit (SK), and Amulet cultivars were 
less susceptible and did not differ significantly. 
The determinate cultivars of faba bean Granit and 
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Table 2  
Tabela 2 

Analysis of variance of area of necrotic lesions produced by A. fabae and B. fabae isolates on six cultivars of faba bean 
Analiza wariancji powierzchni plam nekrotycznych wytwarzanych przez izolaty A. fabae i B. fabae na sześciu odmia-

nach bobiku 

Source of variation   
Źródło zmienności 

Ascochyta fabae  
(10 izolates / 10 izolatów )  

Botrytis fabae  
(4 izolates / 4 izolaty )  

F Pr > F F Pr > F 

Cultivar / Odmiana  10,037 0,000 3,570 0,005 

Isolate / Izolat  19,557 0,000 55,716 0,000 

Date / Termin  62,114 0,000 153,423 0,000 

Cultivar × isolate 
Odmiana × Izolat 

1,971 0,001 3,723 0,000 

Cultivar × experiment 
Odmiana × date 

2,137 0,064 0,857 0,576 

Izolate × experiment 
Izolat × date 

6,801 0,000 10,649 0,000 

Fig. 3. Pathogenicity of isolates of A. fabae towards six faba bean cultivars evaluated using detached leaves technique. 
Isolates marked with the same letter are not significantly different at α = 0.05 (analysis of variance, Fisher’s LSD test)

Rys. 3. Zróżnicowanie agresywności izolatów A. fabae wobec sześciu odmian bobiku określone z wykorzystaniem techni-
ki odciętych liści. Izolaty oznaczone tą samą literą nie różnią się istotnie statystycznie dla α = 0,05 (analiza wariancji, test 

NIR Fishera)  

Table 3  
Tabela 3 

Analysis of variance of area of necrotic lesions produced by A. fabae and B. fabae isolates on six cultivars of faba bean-
Analiza wariancji powierzchni plam nekrotycznych wytwarzanych przez izolaty A. fabae i B. fabae na sześciu odmia-

nach bobiku 

Ascochyta fabae (4 izolates / 4 izolatów ) Botrytis fabae (2 isolates / 2 izolaty )  Source of variation  
Źródło zmienności F Pr > F F Pr > F 

Cultivar / Odmiana  6,963 0,000 2,634 0,036 

Isolate / Izolat  1,223 0,309 0,183 0,670 

Date / Termin  58,043 0,000 110,024 0,000 

Cultivar × Isolate 
Odmiana × Izolat 

1,177 0,314 6,116 0,000 

Cultivar × Date 
Odmiana × Termin 

1,817 0,123 0,711 0,710 

Izolate × Date 
Izolat × Termin 

0,089 0,966 0,492 0,615 
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Fig. 4. Resistance of fabae bean cultivars to 4 isolates of A. fabae evaluated using detached leaves technique. Cultivars 
marked with the same letter are not significantly different at α = 0.05 (analysis of variance, Fisher’s LSD test) 

Rys. 4. Odporność odmian bobiku na porażenie 4 izolatami A. fabae określona z wykorzystaniem techniki odciętych 
liści. Odmiany oznaczone tą samą literą nie różnią się istotnie statystycznie dla α = 0,05 (analiza wariancji, test NIR 

Fishera) 

Optimal showed medium or low susceptibility to 
infection of detached leaves with Ascochyta 
blight. Meanwhile, under natural infection condi-
tions in the field, they were most severely affected 
by Ascochyta blight (Boros et al. 2014; T. Góral, 
unpublished). Similar results were obtained by 
Zakrzewska (2004) comparing the resistance of 
traditional forms and determinate forms of faba 
bean after inoculation with A. fabae in several 
years of field experiments. The results may sug-
gest that there is no direct influence of the gene 
determining the terminal inflorescence (Vf_TFL1) 
on the resistance of faba bean to Ascochyta blight 
(Avila et al., 2007). The increased susceptibility of 
determinate cultivars to Ascochyta blight in field 
conditions is somewhat due to the much shorter 

stem length of these cultivars (about 30-40 cm 
according to COBORU data) (Jellis et al., 1985; 
Pritchard et al., 1989; Zakrzewska, 2004). 

The isolates of B. fabae also varied (Table 1, 
Fig. 5). Two groups of isolates were distinguished 
according to the size of the necrotic lesions. The 
first included two isolates with high pathogenicity: 
BF 3, and BF 1. The second group had two iso-
lates with significantly lower pathogenicity: BF 2 
and BF 4. The differences between the isolates in 
both groups were not statistically significant. 

The faba bean cultivars differed statistically 
significantly in terms of resistance to chocolate 
spot caused by the two isolates with the highest 
pathogenicity (Table 2, Fig. 6). The cultivars Opti-
mal (SK) and Kasztelan showed the highest re-

Fig. 5. Pathogenicity of isolates of B. fabae towards six faba bean cultivars evaluated using detached leaves technique. 
Isolates marked with the same letter are not significantly different at α = 0.05 (analysis of variance, Fisher’s LSD test)

Rys. 5. Zróżnicowanie agresywności izolatów B. fabae wobec sześciu odmian bobiku określone z wykorzystaniem techni-
ki odciętych liści. Izolaty oznaczone tą samą literą nie różnią się istotnie statystycznie dla α = 0,05 (analiza wariancji, test 

NIR Fishera) 
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Fig. 6. Resistance of fabae bean cultivars to 2 isolates of B. fabae evaluated using detached leaves technique. Cultivars 
marked with the same letter are not significantly different at α = 0.05 (analysis of variance, Fisher’s LSD test) 

Rys. 6. Odporność odmian bobiku na porażenie 2 izolatami B. fabae określona z wykorzystaniem techniki odciętych 
liści. Odmiany oznaczone tą samą literą nie różnią się istotnie statystycznie dla α = 0,05 (analiza wariancji, test NIR 

Fishera) 

sistance, the cultivars Amulet and Albus the low-
est. However, the variation in cultivar resistance to 
chocolate spot was lower than that observed for 
Ascochyta blight (Table 2). This was also con-
firmed by several years of observations of the oc-
currence of chocolate spot in field conditions in 
Radzików (Boros et al. 2014; T. Góral, un-
published). In years with high severity of choco-
late spot, most cultivars were affected similarly. 
Only determinate cultivars stood out, in which the 
severity of the disease (assessed as the degree of 
leaf infection on the entire plant) was greater. The 
results of published studies also show slight varia-
tion in the resistance of faba bean genotypes to 
chocolate spot (Sillero et al., 2010). The problem 
in resistance breeding is the lack of good sources 
of resistance to this disease. Most of the identified 
resistant genotypes come from the Andean regions 
of South America and are not adapted to European 
conditions (Bond et al., 1994; Maalouf et al., 
2016). 

Figure 7 shows the successive stages of meas-
uring the area of necrotic lesions described in the 
Material and Methods chapter. The defined meas-
urement process is only an example of using the 
ImageJ program. It can be modified with extensive 
software options, adapting them to your needs 
(Abd-El-Haliem, 2012; Mutka et al., 2015). Stew-
art et al. (2016) developed a macro for the ImageJ 
program to assess the severity of Septoria blight 
(caused by Zymoseptoria tritici) in wheat leaves. 
For each leaf, the macro enabled measurement of 
the total leaf area, total necrosis area, number of 
pycnidia, average size of pycnidia, and the pycnid-
ia gray value. The latter feature indicates the in-
tensity of melanin production by isolates of Z. trit-

ici, a compound that plays an essential role in the 
pathogen’s virulence (Lendenmann et al., 2014). 
Elliott et al. (2022) compared image analysis 
methods using ImageJ and machine learning to 
assess cassava Xanthomonas infection. The au-
thors found that both ways accurately distin-
guished and quantified the different types of le-
sions caused by Xanthomonas on cassava leaves. 
The ImageJ method was more helpful in analyzing 
smaller datasets because it required the user to 
create a mask for each image. 

Obtaining precise measurements requires uni-
fying the photos taken of leaves with disease 
symptoms. The methodology is described, for ex-
ample, in the work of Bartosiak (2020) on the as-
sessment of leaf infection of wheat seedlings inoc-
ulated with the Parastagonospora nodorum fun-
gus. Bartosiak (2020) also proposes automating 
disease symptom assessment using Phyton lan-
guage applications in his work. It is an application 
specially developed to evaluate leaf damage and 
makes the work faster and easier than the rather 
complicated ImageJ program. Similarly, Alheeti et 
al. (2021) indicated that the use of ImageJ to as-
sess leaf infection by two fungal pathogens is 
more laborious than the Leaf Doctor application 
(free application for iPhone) (Pethybridge and 
Nelson, 2015). The development of plug-ins for 
ImageJ may be a solution to this problem. An ex-
ample is an HTPheno plugin developed at the 
Leibniz Institute of Plant Genetics and Crop Plant 
Research (IPK) (http://htpheno.ipk-
gatersleben.de/) (Hartmann et al., 2011). This plug
-in can be used for automated image analysis in 
high-throughput plant phenotyping. 

 

http://htpheno.ipk-gatersleben.de/
http://htpheno.ipk-gatersleben.de/
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Fig. 7. Necrotic area measurement using ImageJ software. A. Necrotic lesion on faba bean leaf caused by A. fabae; B. 
Highlighting necrotic lesion; C. Outline of the highlighted area; D. Measuring the area of the lesion. 

Rys. 7. Pomiar powierzchni plamy nekrotycznej przy użyciu programu ImageJ. A. Nekroza na liściu bobiku spowodo-
wana przez grzyb A. fabae; B. Wyróżnianie obszaru plamy; C. Obrys wyróżnionego obszaru; D. Pomiar powierzchni 

plamy 

Summary of results 

1) The variation in the pathogenicity of A. fabae 
and B. fabae isolates towards the studied faba 
bean cultivars was statistically significant. 

2) Faba bean cultivars showed statistically sig-
nificant differences in resistance to Ascochyta 
blight (A. fabae) and chocolate spot (B. fa-
bae). 

3) The results of the analysis of variance 
showed that the variation in the resistance of 
the cultivars to the chocolate spot was lower 
than that of the resistance to Ascochyta 
blight. 

4) The image analyses show the usefulness of 
the ImageJ software for assessing leaf infec-
tion by faba bean pathogens. 

 

The research was carried out under the Multian-
nual Programme "Creating Scientific Founda-
tions for Biological Progress and Protection of 
Plant Genetic Resources as a Source of Innova-
tion and Support for Sustainable Agriculture and 
Food Security of the Country" financed by the 
Ministry of Agriculture and Rural Development, 
implemented at IHAR-PIB in 2015-2020. 
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